Face-to-Face Meeting:
Wednesday, April 17, 2019
Young at Art Museum
3:30 p.m. - 4:30 p.m.
Skype Session
Thursday, April 18, 2019

] O O Or Esfcbllshed lp m.

_ @ BEQWARD e
County Public Schools



e ENnd of Year Assessments
‘What's New

L et’'s Review

* Preparing for Next Year
« Reminders

« Upcoming Events




BROWARD’S ENGLISH LANGUAGE LEARNERS

Broward'’s active ELLs
speak 186 languages

55% of Hispanics
born in
Haitian-Creole Over 91 % of the U.S.A
ELLs speak
Porluguese I 51% —— OF:C the Venezuel.e!
. } Haifi
Russian | 1.1% top five Colombia
. languages. o Brazil
Vieinamese | 1.0% The remaining Honduras
457 of Cuba
B ° g’ Dominican Republic
Each of the other 122 OOLE) S Guatemala [ 2.9%L€5S than 1% of
languages are spoken by gchvg ELLs orfe Fl Salvodor = 28%FE| s are born in
less than 1% of ELLs. Nt in one o concor W 13, €OCH OF the other
° 167 countries Fcuador [l 1.6%

rerv [l 177 Qddifional 128

Argentina [l 1.5% CoOuUNTries.
Vietnam [ 1.0%

=== *Students (Ages 3-21 years) in grades KG-12 enrolled in public schools, chor’r_




Congratulations & Thank You for the
successful administration of ACCESS for

ELLS!

ACCESS Scores should arrive before the end of the school

yearl!

\




2018-20192 FSA Accommodations

Flerida

Standards Assessments

20182019
FSA Accommodations Guide

Accommodations for English LLanguage Learners (ELLs

All ELLs participate in statewide assessments. Students who are identified as ELLs must be provided with
the allowable accommodations listed below and on the following pages.

2018-2019 FSA Accommodations Guide

FLORIDA DEPARTMENT OF
EUDUCALITUIN
_— fldvearg




Accommodations

ELLs receive accommodations during
statewide assessments AND daily instruction

o~ ~/ ~ An approved glossary is defined as
Flexible _ _ word-to-word and may include
Scheduling/ Assistance In content specific vocabulary

Heritage
Additional Languagge

Time

_— N\ /

Flexible Bilingual

- Dictionary/
Setting Glossary

o AN Y

Free Printable Content Gl
https://steinhardi.nyu.edu/metrocente



https://steinhardt.nyu.edu/metrocenter/resources/glossaries
https://steinhardt.nyu.edu/metrocenter/resources/glossaries

Accommodations

ELLs receive accommodations during
statewide assessments AND daily instruction

o~ An approved glossary is defined as
Flexible word-to-word and may include

Scheduling/ Aslfli:ﬁ?tgcii” content specific vocabulary
Additional L anguage

\‘ D. Approved Dictionary and Glossary

/ * ELLs should have access to an English-to-heritage language translation and/or heritage
language-to-English translation dictionary or glossary or both, such as those made available to
ELLs in an instructional setting. Glossaries containing content specific word-to-word translations
in heritage language can also be provided. The dictionary or glossary must provide word-to-word
translations only and may not contain definitions or other information. A dictionary or glossary
\‘ written exclusively in the heritage language or in English shall not be provided. Electronic

translation dictionaries or glossaries that meet the same requirements without accessing the
Internet may be used.

20182019 FSA Accommodations Gude

Free Printable Content Gl
https://steinhardi.nyu.edu/metrocente



https://steinhardt.nyu.edu/metrocenter/resources/glossaries
https://steinhardt.nyu.edu/metrocenter/resources/glossaries

Flexible Setting Letter

District and Statewide Testing: Flexible Setting Accommodatigg

Wt for Speakers of Other Languages (ESOL)
05 test administrator.

al

Sincerely,

Principal Thesigres
3B

Original: Parent
Copw: ELL folder


https://browardschools.instructure.com/courses/598658
https://browardcountyschools.sharepoint.com/sites/Intranet/Academics/learning/ELL/Pages/default.aspx

Promotion Criteria

Retention- Policy 6000.1

« ELLs with less than 2 years of instruction cannot be
retained solely due to the lack of proficiency in English.
(based on DEUSS Date)

« Third graders with less than 2 years of instruction are
promoted via Good Cause Promotion

(Section 1008.25(6),F.S.)

A formal retention recommendation for an ELL must be
made through the action of an ELL Commiffee meeting,
and a parent must be invited

Policy 6000.1 can be found at www.browardschools.com in the Our
School Board tab



http://www.browardschools.com/

BILINGUAL

It is important for school personnel to explain grading criteria and expectations to parents
of ELLs. Parents must be informed that grading reflects their child’s academic achievement,
based on his or her language proficiency, through curriculum accommodations and the used
of ESOL instructional strategies. This must be documented on report cards, interim reports,
and/or parent conference forms. Parents of ELLs must be informed in a timely manner when
their child is not performing/achieving according to standardized grade level assessments.
For more information regarding promotion or retention of ELLs, refer to School Board Policy
6000.1.

The School Board of Broward County has revised Policy 6000.1 Student Progression Plan in
order to align the policy with current state and local requirements. This policy includes areas
such as: Promotion criteria, Alternative promotion criteria: Good Cause, Student Retention
and Reporting Student Progress. Refer to this policy and its corresponding Procedural
Manual for additional information. All retentions must be referred to an ELL committee and
documented in the ELL Plan.

Source: Policy 6000.1




BILINGUAL

Darand MCamamasrmigadiag |

3. English Language Learners (ELL)

a. Formal retention recommendations for English Language Learners (ELLs) in grades

K-2 and 4-5 require the review and approval by an ELL committee, in which the parent
must be invited (Meta Consent Decree,1990).

1. ELL students cannot be retained solely due to lack of proficiency in English.

2. Progress monitoring and interventions, as well as ELL committee
recommendations, must be documented in the student’s ELL Plan.

The School Board of Broward County has revised Policy 6000.1 Student Progression Plan in
order to align the policy with current state and local requirements. This policy includes areas
such as: Promotion criteria, Alternative promotion criteria: Good Cause, Student Retention
and Reporting Student Progress. Refer to this policy and its corresponding Procedural

Manual for additional information. All retentions must be referred to an ELL committee and
documented in the ELL Plan.

Source: Policy 6000.1




Considerations for Promotion/Retentiun of

English Language Learners 12 Grade 3

As defined 1n Section 1008.25(6). F.S., the good cause exemption for third-grade English
Language Learners (ELLs) 1s:

Limited English proficient students who have had less than 2 years of instruction in an English
for Speakers of Other Languages program based on the initial date of entry into a school in the
United States.

School and district administrators may consider if the good cause exemption is also appropriate
for ELLs traveling in and out of the country, who have not had two years of instruction in an
English for Speakers of Other Languages program. To make a good cause decision, an ELL
committee should be convened where documentation on the student’s English language progress
1s evaluated. Considerations may include:

* Length of time the student has been in each country

* Student level of English language proficiency

* Academic experience in both English and the heritage language
* Transcripts from schools outside the United States

Applicable withdrawal and reentry codes in Appendix A: Attendance Recordkeeping Required
Codes for Grade PK-12 Students

'-f. - :-JLL‘HLL'I'LJ“I"\.Rl‘HI‘-l (W]
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Considerations for Promotion/Retentiun of

English Language Learners 12 Grade 3

As defined 1n Section 1008.25(6). F.S., the good cause exemption for third-grade English
Language Learners (ELLs) 1s:

Limited English proficient students who have had less than 2 years of instruction in an English
for Speakers of Other Languages program based on the initial date of entry into a school in the
United States.

Criterion #5: English Language Learner (ELL) student with less than two years of
ELL Program Participation instruction in the English for Speakers of Other Languages (ESOL)
program based on the initial date of entry into a school in the United

States.
Criterion #6: English Language Learner (ELL) student with two or more years in the
ELL Committee English for Speakers of Other Languages (ESOL) program based on the
Recommendation initial date of entry into a school in the United States cannot be retained

solely due to lack of English proficiency. Retention requires the
recommendation of an ELL committee.

*  DIUQENt IEVEl OI CNEISN IANZUAZE Pronciency

* Academic experience in both English and the heritage language

* Transcripts from schools outside the United States

Applicable withdrawal and reentry codes in Appendix A: Attendance Recordkeeping Required
Codes for Grade PK-12 Students

"
S FLORIDA, DEPARTMENT OF
-
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Functions of the ELL Committee

Effective July 1, 2018

Function
« Resolve any issues
affecting instructional
decisions of an ELL

« May make program
placement
recommendations

Members

Minimum of@SchooI Personnel
Administrator or designee

ESOL teacher

Home language teacher (if
applicable)

Classroom/subject area teacher(s)
School counselors, school social
workers, school psychologists
Other educators as appropriate

* Meeting must be

performed on ELLevation  Parents must always be invited to attend

(Dated Parent Invitation letter)

*Signatures in blue or black ink are required for all participants including administrators.
Parent(s) and/or guardians are always invited, however, if they do not attend, the
meeting still take place. The outcome of the meeting is made available to parents in
writing via the Parent Notification Letter in their native language and filed in the ELL Folder.




FTE Audit for

ESOL at a Glance Detailed Requirements 2018-2019

ELL Folders/ELL Plans

Annual Reviews

REEVALS

OO0 Flexible setting requires a dated parent
notification letter to be sent home and a
copy filed in ELL folder

O Generate, save, print, and file ELL Plan*
with updated accommedations in ELL
Folder

Section 5 of ES0L Handbook

After 48 hours, check if data is updated
an ELLevation

Generate ELL Plan*. Save, print and file
in ELL Falder

Section 6 of ES0L Handbook

signed and dated Student Meeting
Report

section 6 of ES0L Handbook

nitiate an ELL Folder for students who O Based on student’s DEUSS Date (e.g. O Based on student’s DEUSS Date (e.g. August
ualify for the program August 2017 and August 2018) for years 2015, 2014, 2013, etc..) for years 4 and beyond
20 ] 7—20 ] 8 SY mplete student demographic Zand3 O schedule and invite parents to an ELL Committee
rmation and one box per year O Conduct Annual Review Meetings* on meeting. Print and file in the ELL Folder.
fo r S e | e C‘I‘ dicating the required documentation is ElLevation (within 30 days prior to O Conduct a meeting® on ELLevation
nclosed anniversary date) (within 30 days prior to anniversary date)
O Complete Programmatic Assessmentand | [0 Generate, print, and sign Student O Use ACCESS and FSA scores to make
| O C O TI O nS Academic Placement Review (back of Meeting Report® determination of continued placement
folder) O File a copy of the Student Meeting O Generate and print Student Meeting Report*with
Generate ELL Plans* to demonstrate Report in the ELL Folder all present participants’ signatures
current services (current schedule, O Provide IMT/IMS with updated PLAN O File a copy of the Student Meeting Report in the
O testing accommeodations, assessment Date to enter on A23. PLAN DATE is the ELL Folder
on ELLevation scores, etc.). Save, print and file in the day of the “meeting” O Provide IMT/IMS with updated PLAN Date to
O Generate ELL Plan®. Save, print and file ELL Folder O After 48 hours, check if data is updated enter on A23. PLAN DATE is the day of the
in the ELL Folder At the beginning of the year, sign and on ELLevation “meeting”
O Send dated Notification of Placement date ELL Folder. Use checklist on ELL O Generate ELL Plan*. Save, print and file O After 48 hours, check if data is updated on
letter* home Folder to ensure all required documents in ELL Folder ElLevation
O File a copy of the letter in ELL Folder are filed O Send dated Motification of Continuation | 00 Generate ELL Plan®. Save, print and file in ELL
To order folders, email quantity, contact of Services*letter home Folder
name, and school name to: O File a copy of the letterin the ELL O Send dated Notification of Continuation of
esolreguests@browardschools.com Folder Services*
O File a copy of the letter in the ELL Folder
Sections 1 & 2 of ESOL Handbook
Section 7 of ESOL Handbook Section 7 of ESOL Handbook
Section 3 of ESOL Handbook
Accommodations Exit Post Exit Monitoring ELLevation
O Assign on ELLevation: Student List-> If student met State criteria, ETS will O Monitor LF students for 2 years O Use Student List to identify ELLs on @ monthly
Active LY Students->Assign->Edit->Assign automate the exit process on TERMS O Monitoring is completed at four basis (Student List ->Views -> Shared With Me -
Accommodations® (PLAN & EXIT Date, Basis of EXIT, TIER, specified times based on the exit date »>Reports -> Active LY Students-> Export to C5V)*
O Provided to LYs on a regular basis (for LEP Status, and Program Code) O LF Monitoring Year 1: 1% report card, O Use Data Dashboard to identify languages
teacher-created tests, chapter tests, as If student is exited via ELL Committee, End of 1% semester, and End of 1** year represented by number of LYs and LFs (Student
well as statewide assessments) conduct @ Meeting on ELLevation® O LF Monitoring Year 2: End of 2™ year List -»Shared View “Composite”)*
O Documented on teachers’ lesson plans O Conduct a Post-Exit Monitoring O Generate required letter: Student List -> Select
O State approved accommodations are: After Student Has Exited: Meeting™ all students from Saved View of LY->Reports-
Flexible Scheduling, Assistance in the mn of EXIT* O Gather information from classroom »Select Parent Letter-» Adjust Parent Letter
Heritage Language, Approved Dictionary |etter and file in ELL Folder teacher (grades, progress, etc.) Options->Generate Letter->Print*
and/or Glossary, Flexible Setting O File current report card along with a O Generate ELL Plan: Student List->Select all or

individual students from Saved View-> Reports -
>ELL Plan-> Save->Print*

section 12 of ESOL Handbook

*To be completsd on ELLevation

CC/VBS/SB/AP 03/20/2018




At a Glance

ESOL Compliance for Administrators

2018-2019
AugustfSeptember October November/December January
O Exiting Procedures O Registration, Testing & Placement O mRegistration, Testing & Placement O Registration, Testing & Placement
(ETS/ACCESS/FSA) Procedures new students (Update Procedures new students (Update Procedures new students (Update
O Registration, Testing B Placement AD3, A24, A23) AD3, 821, A23) AD3, A21, A23)
Procedures (Update A03, AZ1, A23) O aAnnual Reviews* [DEWSS Oct. 2016 O annual Reviews * [DEUSS Nowv./Dec. O aAnnual Aeviews* (DEUSS Jan. 2017
O wpdate ELL Folders for Ly students and 2017) 2016 end 2017) and 2018)
| Assign Accommodations, chedk Re-Evaluations* (DELISS Oct. 2015 [0 Re-Evaluations® (DEUSS Nov./Dec. O ReEvaluations® (DEUSS jon. 2016
schedule, Update ELL PLAM*) w ELL and before)] Requires ELL Committes
O annual Reviews* [DEUSS Aug fSept. 2 - M L/s/mSw Meeting® and LS/ R, W Assessment
2016 and 2017} o O Registration, Testing & Placement O Send dated Notification of
O Re-Evaluations* |DEUSS Aug./Sept O Placement/Continuation letter*
2015 and before) Plad] "m""rm(w lettert O File ELL Plan/Parent Letter
O update PLAN DATE on AZ3 O File AD3, A21 A23 O update PLAN DATE on A23
" rememtommatmies |0 rg| O Anmal Reviews® (DEUSS March/ARY. [ .. | D b rsevion neparse 1 very
O File ELL Plan/Parent Letter 2017 and 2018) o verify Data Entry
O FRun ELLevation Reports® to verify u Re-Evaluations*® (mmwm O Begin planning for ACCESS
Data Entry 5 > admin/Fsa
2016 ond before) Requires ELL
February Committee Meeting* and L/S/R/W
O Registration, Testing & Placement [m] Assessment Jacement
Procedures new students [Update ? ” [update
AD3, AZ1, A23) soz]| O Send dated Notification of
O Anmual Reviews* (DEUSS Feb. 2017 Placement/Continuation letter® May/ume Please refer to the Bilingual/ESOL
and 2018} 201 website for detailed procedures located
O ReEvaluations* (DEUSS Feb.2015 O File ELL Plan/Parent Letter E,,/M in the
nd before) e e commies | 241 O Update PLAN DATE on A23 e ESOL Program Handbook
O send dated Notification of O update ELL Folders and ELL Plans* :;_rsmpurtc:nm
Placement/Continuation letter® | O mmmow‘w' ¢ ingual/ESOL Dept
O File ELL Flan/Parent Letter leter* 754-321-2590
O update PLAN DATE on AZ3 O File Data Entry
O wupdate ELL Folders and ELL Plans* [m]
O FTE Verification Survey 3 - Run O upd - | Plans®
ElLevation Reports® to verify Data O Pun ELLevation Reports® to verify O Run ELLevation Reports® to verify
Entry Data Entry Data Entry
O Retention Meetings*

*Ta be complsted on ELLevation
WES/OC/AP 07/ 23,18




At the end of this school year or
beginning of the 2018-19 school year...

Students who qualify to Exit will be exited
automatically.

Schedule ELL committee meetings for students
requiring an extension of services (REEVALs).
Generate and Send home a Nofification of
Continuation of Services Letter or Notification
of Exiting ESOL Status Letter as applicable
Administer [PT to any students who enter new
to Broward County (within 20 days of
reqgistration)




ACCESS FOR ELLS 2.0 RESULTS

Results will provide: Results will NOT be

used for;
scale score data for

monitoring student progress

over time within a language * grade-level placement
domain » grade promotion or retention
data for charting the progress decisions

of newly arrived students

information about individual
students that will be used in
making decisions regarding
exit from the ESOL programs *

information about individuadl
students ‘ strengths and areas
of need in English

*Exit criteria is deiermine_



ACCESS for ELLs SAMPLE

INDIVIDUAL STUDENT REPORT

WTDA | ssstsmmesy,  SEunitim e o

communicate in whting in English using language related to <m-mmp.= in school, for cxample
Writing 3 - Describe familior Ezues and cvents and detai
- Create stories or short narratives Gvcep-mens-ﬂhm: a few shoet sentences

For dealis regarding the scores Co this sepoe, ofor 10 the lnterpecthve Cuide for SCome Reapans 3t wwwwics se/scomerepon

Individual student results are reported as scale scores and English
language proficiency scores in Listening, Speaking, Reading & Writing

ACCESS for ELLS 2.0 Interpretive Guide is available at wida.us
More reports can be pulled from WIDA AMS (Principals have access)

hitps:/ /www.widq.us/membership/staies/_




What’s the difference?

REEVALS
For students entering a US school in 2015-2016 or earlier

Recommendations for continued placement for
ELLs entering years 2 and 3 based on DEUSS
Date (within 30 days)

* ELL Committee Meeting is not required
+ Complete Me, Myself & | Meeting on
ELLevation

* TERMS: Update ELL PLAN Date
» Generate Parent Letter (Notification of
Continuation)

Generate and Save ELL Plan within the required
30 day timeline and file in ELL Folder

A

vy ANNUAL REVIEWS AND REEVALS

Recommendations for ELLs entering years 4, 5,
6 and beyond based on DEUSS Date (within
30 days)

* ELL Committee IS required.

« Current data must be reviewed to make
recommendation for continuation of
services.

« After Oct. 1t IPT assessment (L/S/R/W) must
be administered; however, do not update
language classifications

 TERMS: Update PLAN Date and REEVAL
date on TERMS (date of ELL Committee
Meeting and PLAN date shall match)

» Generate Parent Letter (Notification of
Continuation)

Generate and SaveELL Plan within the
required 30 day timeline and file in ELL Folder

0 |




Meetings and Decisions

anll Ellevagicn — List Student M. 5=

E EEU'H.T“]H My Home & Swwdents — S Reporis — Bl Resowoes — % Admin -
2nd Year Annual Exvalusthon Bra Wear Amnual Evaluation aih veoar Reewaluation Sth Wear Recwaluation
BIh Wear Feews Iuamsor SAuocitonal ReawahuStion MMe-sting Plae I~ Post-Exit Monitoring Meeteng
il g TEhoe a

3 cents meeet the se criteria [Clear Fibers]
Stusdent Mame
oo " FMEETING =
[l STUDHEMNT < SRAaDE o C = TE o
Schools
Siher Lakos Elerme DLARGS, LIS, Wiews Meeting
= HOETSOAT OIS BMR2ONS BMASS2C
P —— Delete Meeting(s)
e = th:ﬁ' nglgr;_ B2 RCOMS SUROE - -
Temcher LA RENT
o = =] SE R IR, TR OV RO = -
HOENSO T F2S9
- [Drreee])
Showing 1Tto 3 of 3 = First « Prewious 1 Pext > Last =
A -

Remember 1o generate Student Meeting Report
at time of meeting.
After 48 Hours: Print Parent Notification Letter and ELL Plan




Document Storage

» Choose the student for whom you want to add documents. You
can click on the student’'s name from the Student List or Search.

> |In the Student Profile, select the “Document” tab

it | seect sdent epot [+ T

Demographics |

ELP Testing Accommodations ‘ Modifications | Goals | Monitoring = History
Shelley Abadia Botero 99500100 Crofton Elementary A

Home Language Survey

Initial Classification Form

Documentation to substantiate REEVAL decision
Documentation to substantiate Retention/Promotion decision
Conference Form

ELL Committee Invitation Letter

ELL Committee Meeting Report (with signatures)

Flexible Setting Letter
Interim Reports
Poriffolio Samples
Student work samples
Report Cards
PMPs/AIP/RTI

O O O O O O ONCHECENGENEEEE




E! ﬂ EVATION Demo Database for Trainers n

Home Studems v Schools Teache

Reports v Instruction ~

HOME STUDENTS PALHAMC MARILA AZUL Filter: Maone
p PALHANO MARIA AZUL Select Student Report w + Data Audit
TestID #GA

School: DeLlllo Academy Composite: 4.1 - Expanding
Grade: 2 - 5.9 - Bridging
Language: Spanish Speaking: 5.9 - Bridging
LEP Status: ELL Reading: 4 - Expanding
Entered LEP: Writing: 3.E - Developing

Literacy: 3.8 - Developing
B View Test Results

Demographics | Schedule | ELP Testing = Accommodations | Modifications = Goals = Menitoring | History | Mestings | Instruction Documents

T e e rs s o Document Storage
Naming Guide

Choose File |No file chosen

Maximum file size is IMB

Document Type:

Documentation to Substantiate REEVAL

Supported Files: pdf, doc, docx, xIsx,
csv, or image (png, jpg, gif)

Document Name:

Teacher Recommendation

Description:

Recommendation for continued -

placement in the ESOL Program y

Please Note: This document will be visible to
Ellevation users with access to this student’s
record in Ellevation. Please follow your
District and State's guidance as to which

documents should be added to student




ELLevation Meeting Notes

T Listening 23/ Speaking 23/LES
Grade: 4 Reading O/NER Writing O/NEW

Language: Spanish B View Test Results
LEP Status: LY (ELL Current)

HR Teacher SN

ESOL Program Entry Date: 8/19/2013

national criterion-referenced standards. (Documentation must be attached).
| Grades from the current or previous years.

+/ Test results other than those used in initial language proficiency assessment. (Documentation must be attached).

Meeting Motes

There are no notes for this meeting

To add a note, re-open the meeting.

Generate Report




Sample
ELL Plan

i

Program 130,
Accommodations
plan date

test scores

El!ﬂmnuu

o
af27/2018

ELL Plan Mudest:
Broward Courty Public Schoals Report:

m 2-39 BM Page: 1
Student Information

Btudent: Test ID #: Student #:

Gender: Date of Birth:

School: Winstan Park Elermentary

Hispanic/Latino: Teacher:
Bhone/Cell: Address: Grade Level: K
Tarl.ﬂwl:ﬁ:- i Birth Country: United States Homeless: o
puage: Immigrant: No Migrant: e
Active) Mo Homebound: No Bllingual: No
1EP: Mo

ELL Plan Date: 872172017
Basis of Entry: A-fAurel/Oral

ELP Designation: ELL

LP {Pending Proficlency):
Program Particlpation:
Basls of Entry: A-AuralfOral
Basls of Exit {First): Z-fot Available
Basis of Exit (Second):
Tite 111/ Immigrant Ser.:
Other Exceptionality:
Lang. Classiication: 2
Diploma Description: Nk
2nd Date Exited ESOL:

Father:

Lang. Classification: 2

504z No Dual Language: fo

2nd Date Exited ESOL:

ESOL Status: LY [ELL Current) Tler:

Recelving ESOL Swes: Yes

Work: Phone: Interpreting? No

Home Language: Thal

Exlt Date :

‘Date Entered US Schools: B/21/2017
Dstrict Enrollment: 5/21/2017
ESOL Program Entry Date: B/21/2017

ome Language Survey Date: B/21/2017

Years In US School: 2
Graduated:
Withdrawn: &/7/2018
Dropped Out:
Monltored Since:
Monitoring Status: Mot Monitored

Parent Denlal Date: Parent 2
= - ELL Plan Dabe: 872172017
Re-Eval Date: Class Dabe:
‘Graduated: fo Withdrawn: Yes Dropped Gut: Mo Deceased: No
504 Mo SIFE: No
Extended Instruction > 3 Years: No Pre-AP/AP: No ELL Plan Out of Date: Mo
Gifted and Talented: No
Spaclal Education:
Comment:
Chronology
Start Stop Activity rt Stop Activity
1. 6/F/312 6 Years, T months 6 B21/200TF ELL Flan Date
2 B/Y2017 5312018  Accommodations/Exemptions uséd ALL State and Di T B3LaMT IPT Grd: K
Assessments 8 LFI01E ACCESS for ELLs 2.0, K, Grd:
3 B/2y27 ESOL Prograrm Entry Date L4
4, B/21/2017 Date Entered US Schoals 9. 6/7/2018
5 B21/2007 Enrolled in Broward County




Sample
ELL Plan

Program 130,
Accommodations
plan date

test scores

El!ﬂmnuu

ELL Plan Studest:

BrI7018 Broward County Public Schoals Report:
2-30 BM Page: 1
Student Information
Student: Test 1D #: Student #:
Gender: Date of Birth: School: Winstan Park Elermentary
Hispanic/Latino: Teacher:
Phone/Cell: Address: Grade Level: K
Blrthplace:
Birth Co United &
Language: Thai wnkryt Uni tates Homeless: ho
Immigrant: No Migrant: o
Actival Mo Homehound: No
18P Mo Bilingual: No
504z No Dual Language: fo

ELL Plan Date: 8/21/2017

Lang. Classification: 2 2nd Date Exited ESOL:

Basls of Entry: A-Aural/Oral

ELP

Test Date Standardized
Test Scores
1eT 8/3/2017  Ustening (57/) Speaking (57/) Reading (0/) Writing {0/} e e
Listening Speaking nndlng Writing
Test pate 1/ 2/ 34| 5 6 {2/ 34 5|6 _1f2/3/4ls{s _1/2{34 58

AOrEas for LS 252038 gy == T —-——
2.0 (280%)

Accommodations
Year & Semester: 2017/ 2018 - Year ALL State and District Assessments
1 - Flexdibie Scheduling ol

3 - Flexible Setting )

4 - hssistance In the Herltage Language el
Comments / Justification -

Classroom Modifications

Mo Classroom Modifications exdst for this Student.

Monitoring
Mo manitoring activity exists for this student.

Student History
Mo history activity items exist for this student.

Notes
Data shown on Broward County Schooks reports may include confidential information which should not be disserninated without prior written approval. >
Secure any printed coples appropriately or destroy coples when no longer needed.

Spaclal Education:

Comment:
Chronology
Start Stop Activity rt Stop Actlvity
1. 6252012 6 Years, 2 months & B/21/2017 ELL Flan Date
2 B/W2017  S/3/201B  Accommodations/Exemptions used ALL State and Di 7. B3L2017 IPT Grd: K
Asgessments 81/ 201E ACCESS for ELLs 2.0, K, Grd:
3, B/21/2017 ESOL Prograr Entry Date ¥
4, B/21/2017 Date Entared US Schoals 5. 6/7/2018
5. B/21/2017 Enrolled in Browand County




Generating ELL Plans

» At the beginning of the
school year for all LY
students.

» At the end of the year
for students that met
exit criteria

AND

Anytime there is a(n):

* Annual
Review/REEVAL

 ELL Meeting

* Change in Program
Services (Schedules)

« Changein
accommodation

Before Printing...

» IMT updates the PLAN
Date on A23

» Wait 48 hours

» Check that data is
updated on ELLevation

» Generate and “save”
ELL Plan with date in a
timely manner

» File updated ELL Plan

in ELL Folder
*Note: Never discard an ELL PLAN




PARENT NOTIFICATION

Notification of English Language Program Placement or Continuation

Student: Katharine Orega-Pascual School: Hoower High
Grade Lavel: 8 LEP Status: ELL

Our school district provides a program of language instruction for English Language Learners (LEPs) to attain English
proficiency, and meet the same challenging academic content and student achievernent standards expected of all
students.

Upon enrolimeant, a language other than English was noted on your child's Home Language Survey. According to state
and federal law, our school district is required to assess the English language proficiency of your child in listening,
speaking, reading, and writing. Based on the results of the ACCESS for ELLs 2.0, a state-approved assessment for
measuring English language proficiency, we are pleased to inform you that your child is eligibbe for services for English
Language Learmnars. Below, please find results that have informed our decision, information about our language
programs, and your rights as a parent.

Katherine took the ACCESS for ELLs 2.0 on 03/01/2016 and their results are listed below:

Listening Writing Reading Speaking Literacy Composite
5 5 4.5 5.5 4.8 4.9

The ACCESS for ELLs test results are ranked into the following categorias:

# - Proficiency Lewvel - Description

1 - Entering - Knows and uses minimal social language and minimal academic language wilh visual suppon
2 - Emerging - Knows and uses some social English and general academic language with visual support

3 - Developing - Knows and uses social English and some specific academic language with visual support
4 - Expanding - Knows and uses social English and some technical academic language

5 - Bridging - Knows and uses social and academic language working with grade level material

6 - Reaching - Knows and uses social and academic language at the highest lewvel measured by this test

Additional factors used to determine your child’s program eligibility:
Committes determination

Teacher's recommendation

Classroom parformance

Teachers of English Language Learmners provide a variety of specialized services until students demonstrate skills in
English sufficient for thermn 1o succesad academically in the regular classroom.

Your child receives the following English language development instruction:

Content-based ESL: 3 times per Week for a duration of 1:00.

Content-based ESL: An English program that serves identified ELL students in English only by providing a full-tirne
teacher certified to provide supplementary instruction for all content area instruction. The program integrates English-
as-a-second-language instruction with subject matter instruction that focuses not enly on learning a second language,
but using that language as a medium 1o learn mathematics, science, social studies, or other academic subjects.

While the rate of English language development (ELD) varies between students, many exit the ELD program in 3-5
yaars. Your child's English language develspment will be assessed annually until halshe achieves: a Composite scone
of at least 5.0 on the ACCESS, a Writing score of at least 4.8 on the ACCESS, a Reading score of at leas! 4.8 on the
ACCESS, and meels specific academic achievemant requirements. Students who exit tha program are monitorad for
academic success for 2 years,

All children, regardless of English proficiency, are eligible to participate in all schoolkwide programs. If your child has
an Individualized Education Plan {IEF), or a 504 plan, the language instruction educational program will be utilized in
coordination with your child's existing plan. Your child currently has an IEP.

Throughout the school year, you will have many opporfunities to learn about your child's progress in academics and
learning English. | encourage you to altend parent-teacher conferances and school events to support your child's
academic success. Your efforts will help us meet the 2016/2017 expected rate for graduation of 70%.

Demo Databasa for Trainers

When is the "Notification of
English Language Program
Placement Letter” completed
and sent home?

At Initial Placement
AND

Continued Placement:

Annually on anniversary date,
while conducting Annual
Reviews or REEVALS.

At re-entry for students that
leave the country or state for 90
days or more.




Reports and Leftters

M Home ﬂ; Students ﬁ Schools b Teachers E_E Reports !! Resources ﬁ Admin

. nack, Jordan Last Visit: Friday, August 23, 2013 10:12:18 AM

~TAL STUDENTS Student Name or # Q. REPORTS and LETTERS

List Flagged ? Use the options below to select a Report, Parent Letter, Listing,
or Data Analysis for viewing and printing. Click "Reset” at the
Grade bottomn to reset your filters.
¢ [an ¢ Select a Report
Status A
#] [ Al =] -———— REPORTS —-———-

Classroom Modifications Repart
Cumulative Folder Report
ELL Student Plan

Abajo, Juan - Monitoring Report Form
Abajo, Victoria v Scale Score Comparison Report
State Test Accommeodations Report
Abdullah, Kateb A4 Student Goals Report
Student Schedule Report
Abdullah, Dhameer v WIDA ELP Standards Report
————— PARENT LETTERS —-———-
1002703002 ABED, JOAQ - Notification of Exiting LEP Status Letter {For ann...
412345 Notification of Not Qualifying for LEP Status (For...
Notification of Qualifying for ELL/LEP Status
Q " Parent Letter Labels | -
————— LISTINGS -———-
DATA QUICKVIEW I CAN DO Performance Definitions
Clig E pard
ELP Score History
| ELL/ LEP Students j ESL Teacher Schedule (By Time) - Abbreviated

ESL Teacher Schedule By School/ESL Teacher
‘ School: [ All s] Grade: [ all ESL Teacher Schedule By Time




Grading ELLs

* Provide clear, concise directions

« Explain grading criteria and show examples of
finished product

 Document use of ESOL strategies and other
modifications, accommodations, and parent
contacts

* Immediately inform parents about concerns

* For promotion/retention of ELLs, refer to School
Board Policy 6000.1




ELLevation New Features

&




Demaographics

Course Grades

8 Course Grades

Grading Period +
2017/2018 - Semester 1
2017/2018 - Semester 1
2017/2018 - Semester 1
2017/2018 - Semester 1
2017/2018 - Quarter 1
2017/2018 - Quarter 1
2017/2018 - Quarter 1

2017/2018 - Quarter 1

Schedule

ELP Test Results | EL Services and Programs ~ Designated Supports

Grade Level © Course Name
6 Larts Core &

6 Math &

6 Science 6

6 Soc Studies 6

6 Larts Core 6

] Math &

6 Science 6

6 Soc Studies 6

Enable English Learning
In ALL Classrooms

Classroom Supports =~ Goals g  History

All Grades

All Periods

Course Subject

ELA

Math

Science

History and Social Science
ELA

Math

Science

History and Social Science

Update

Motes Meetings Instruction = Documents

- All Subjects -

Grade Received
A

A

Ar

Ax

a L evarion



Can-Do Tab

6 of 24 A W
Return to search

Student Pro|

Select St port

=) w bata nudit J save ] Save/next]

Demographics | Schedule | Test Results = Can Dos @ ES

Classroom Modifications Goals History Notes

Meetings

OL Services Test Accommodations

Instruction uments Course Grades

v A

Grade: 10

ning: 6 / Speaking: 6 /

ina: 0/ IFR_Writinao: 0 / 1 FW

Rea

Language: Spanish

ESOL Status: LY (ELL Current) -

Course Grades

*Name
Domain
*School
Test ID #:
Student #
| @ Listening
Ethnicity:
Race ) White [J Black or African
[J Asian [J American Indial
Flags: O nomMm ) Homebound C
[J Homeless [J Bilingual ]  Speaking
]
& Reading

Schedule Test Results Can Dos ESOL Services Testing Accommodations

Current Descriptors

5: Bridging
Students at this level:

« Carry out oral instructions containing grade-level, content-based language

« Construct models or use manipulatives to problem-solve based on oral discourse
o Distinguish between literal and figurative language in oral discourse

* Form opinions of people, places, or ideas from oral scenarios

4.2: Expanding

Students at this level:

« Answer opinion questions with supporting details

o Discuss stories, issues, and concepts

* Give content-based oral reports

« Offer creative solutions to issues/problems

« Compare/contrast content-based functions and relationships

5.7: Bridging
Students at this level:
* Summarize information from multiple related sources

* Answer analytical questions about grade-level text
o ldentify explain and aive examnles of fiaures of sneech

Classroom Medifications

Goals History Notes Meetings Instruction

Successive Descriptors

6: Reaching

« Student has achieved English proficiency in this domain.

5: Bridging
Students at this level
« Justify/defend opinions or explanations with evidence
« Give content-based presentations using technical vocabulary

* Sequence steps in gradelevel problem-solving
« Explain in detail results of inquiry (e.g., scientific experiments)

6: Reaching

« Student has achieved English proficiency in this domain.

Documents




Preparing for 2019 -2020

A




Pre-K Students

SECTION 11

PRE-KINDERGARTEN

In this section, you will find information on the following:
e Entry Criteria Pre-Kindergarten ELLs
e PreK Local Data
e Exit Criteria for Pre-Kindergarten
e Pre-Kindergarten (Placement) Chart
o Frequently Asked Questions

hitps://www.browardschools1.com/cms/lib/FLO1803656/Centricity/Domain

1571 482/Section%2011%20HB%2017_1 8%20_FIN_



https://www.browardschools1.com/cms/lib/FL01803656/Centricity/Domain/11482/Section%2011%20HB%2017_18%20_FINAL.pdf

Pre-K Students




Pre-K (LY-T) Students (entering Kindergarten)

tested new school year begins

On A23 panel:
Change Basis of Entfry from “T" to “A”

« Change DEUSS and ESOL ENTRY DATE to
the first day of Kindergarten

« Update PLAN DATE to the first day of
Kindergarten

 Update CLASS DATE to the date the IPT
was administered

On AQ3 panel:
« ELL Code remains LY
« Assign language classification (LC) (A1-B2)

On AO03 panel
« ELL Code changes from LY to 77
. Enter appropriate LC (C2, D, or E)




Pre-K students (LY-T) tested the new school
ear begins




Pre-K students (LY-T) tested the new

school year starts

Score

If the recommendation is to PLACE a student in the ESOL
Program:
On A23 panel:
« Change Basis of Entry from “T" to “L"
« Change ENTRY to first day of Kindergarten
« Update PLAN date to the first day of K
« Update CLASS to the date the ELL Committee
Meeting was convened.
+ On AQ3 panel:
 ELL code remains LY
« Assign LC (C1)

If the recommendations is NOT to place a student in the
ESOL Program:
On A23 panel:
« Enter EXIT and update PLAN to the date of the ELL
Committee
On AQ03 panel:
« ELL Code changes to LF
« Assign LC (C2)

. Monitor the student for two ieors



Scheduling Developmental Language Aris (DLA)

« We will continue

Are all Developmental Language to ocjvoco’re for a double block if
Arts ESOL-Reading classes required possible :
to be single block next year or is « Schools will be allowed to offer a

that only a recommendation? single. block of [,)LA ESO",'
Reading especially for high school

students who need the credits for
graduation

Can the English through ESOL « This is not allowed unless

classes be stacked? For )
the same model for is offered for
example, can | put 11th and
. non-ELL classes
12th graders together in one )
. . « The State defines a sheltered
period and run English 3 class as a course where all
through ESOL and English 4

through ESOL at the same students are LY
time?




Scheduling Developmental Language Arits (DLA)

* |t would be ideal to have the Language
Arts 1-3 and English I-IV course back to
Do the classes need to be ﬁ back with the DLA ESOL-Reoding course
back to back? so the students have a continuous block
« The school would have to make
the determination based on the
scheduling needs of the school

the Language Arts class by I-IV are core classes and must
level, or do they have to be be scheduled by Grade Level
by grade as it is currently? « Grades cannot be mixed

Can students be grouped in ﬁ « MJ Language Arts 1-3 and English




' Reminders



Language Enrichment Camp (LEC)

. Title 1ll, Part A Grant funds were made available, through the
Bilingual ESOL Department, to implement the 2018-2019 LEC for
ELLs.

. Focus was on enrichment opportunities in the core content areas
of mathematics, science, and reading to assist ELLs (LY's) with
academic achievement and English language acquisition.

. ALL LECs end on Friday April 12, 2019

. ALL Title Il tutoring sheets & data results (pre & post
assessments) to evaluate the effectiveness of the camp

must be forwarded to lec@browardschools.com no later than Friday,
May 3rd. All necessary templates to complete the pre/post data are on
Sharepoint

For more information contact Leyda Sotolongo at
leyda.sotolongo@browardschools.com



mailto:leyda.sotolongo@browardschools.com

2019 ESOL ACADEMIC
COMPETITION
(Middle & High School ELLs)

THEME: NAVIGATING THE PATH TO BILITERACY
WHEN: SATURDAY, APRIL 27, 2019
WHERE: PIPER HIGH SCHOOL




2019 EAC Registered Schools

b

m )

Middle School

Deerfield Beach
Driftwood

Gulfstream
Lauderdale Lakes
McNicol

Millennium

New Renaissance
Rickards

Rise Academy School of
Science & Technology
Seminole

Tequesta Trace

High School

Boyd Anderson
Blanche Ely
Cooper City
Coral Glades
Coral Springs
Cypress Bay
Deerfield Beach
Everglades
Hallandale
McCArthur
Miramar
Northeast
Piper
Plantation
Taravella
Western

DK 3




Standards Review input requested

Per Gov. DeSantis
Executive Order 19-32,
the DOE is in process of

reviewing the current
ELA and Math standards
and would like your

input



http://www.fldoe.org/standardsreview/

Claudia Campos,

Nilda Aguirre, Community Liaison-
Staff Developer Spanish




Take the Pled:

to adve iLL success in your comr
edges. .
| i

Will you join us and take the
pledge?
bit.ly/ellpledge




Save he

'

Dat e\

e

Seasons of Learning
June 10 -11 or June 12 -13
(Two Day sessions)*
Western High School
ELLevation and Curriculum
Components of WIDA and

Scaffolded Instruction K-5

«  Components of WIDA and

Scaffolded Instruction 6-12

Upcoming Professional Learning

Beginning of the Year
Meeting :
Friday, August 9, 2019

*Funded by Title

Flyer
Coming
Soon|




End of the Year Update

2017- 2018 End-of-Year ESOL Update

> % we continue to receive updates from the State, we will keep you abreast of important information. If you are no
r the ESOL Contact, please provide the updated information to

N

Opening of the ¥ear ESOL Contact Meeting
Date: Friday, August 10, 2018
Location: Nova High School

t 2-DAY New E5S0L Contact Training and Refresher
Contact Training: Register on My Learning Plan

ACTIVITY/AUDIENCE DATES/TIMES LOCATION
ESOLELLevation & Curriculum New Users Mon 6/11/18 & Tues. §/12/18
Audience: New ES0L Contacts or
Prepares ESOL Contacts to implement tols on ELLevation, the web-| weq ¢013 /18 & Thurs, §/14/18 .
‘ based platform used to adhere to distriet, state and federal 113/ urs. 6{14/18 | Western High School
guidelines for English Language Learners (ELLs), impacting
) instructional practices and i 2:00 a.m. - 3:00 pm.
- Mon. 7/30/18 & Tues. 7/31/18 Cooper City
B:00 am. - 3:00 p.om. Elementary
ELLevation and Curriculum Refresher
Aundience: Returning ESOL Contacts Mon. 6/11/18 & Tues. 6/12/18
Prepares Returning ES0L Contacts to implement advanced tools on .
ELLevation, provide curriculum support for teachers in order to Wed. 6/13/18 & Thurs, 6/14/18 | Western High School
adhere to disrict, state and federal guidelines for English Language
Learners (ELLs), impacting instructional practices and compliance, 8:00 am. - 3:00 pm.
Mon 7/30/18 & Tues. 7/31/18 Cooper City
B-00 am. - 3:00 p.am. Elementary
ESOL: Introduction to WIDAK-5
Andience: Educators of ELLs K-5
Prepares K-5 educators to plan and implement the research-based Momn 6/11/18 & Tues. 6/12/18 :
WIDA Framework and the WIDA Can Do Philosophy, in order to L 112/ Western High School
meet the diverse needs of English Language Learners (ELLs) for 8:00 am. - 3:00 pm.
classroom instruction and assessment
- ES0L: Introduction to WIDA 6-12
Audience: Educators of ELLs 6-12
Prepares §-12 educators to plan and implement the research-based Wed. 6/13/18 & Thurs. 6,/14/18 .
WIDA Framework and the WIDA Can Da Philosaphy, in order ta Western High School
meet the diverse needs of English Language Learners (ELLs) for 8:00 am. - 3:00 pm.
1 instruction and

ACCESS for ELLs 2.0 Score Report: The scores were released on May 30, 2018, but notification will be
provided when reports are accessible.

*  Schools will receive one hard copy of the different score reports in English. If additional reports ap
they can be printed from WIDA AMS.

*  Using the WIDA AMS Portal schools can generate individual student reports in
the On-Demand Reports Menu.

*  Principals have access to WIDA AMS for their location using their email address 3
principal has forgotten their username or password, they can click on "forgot us4
the website. If the principal is new to the school, contact victoria.saldala@broyy
their location reassigned.




EVATII]N Access Form

ieS‘QL @ levarion

ELLevation Access Form

ELLevation is a secure web-based system for documentation and monitoring ESOL services
for English Language Learners (ELLs). All documentation in ELLevation is required in
order to meet the state and district ESOL program requirements. Each school will be able to
assign two users per school.

This form is to be completed for access to ELLevation and returned to Vicky Saldala,
Director at victoriasaldala@browardschools.com.
School Name

*For Charter Schools only: One form must be completed per MSID (Location Number).
NEW Users. Staff member that is new to your school that will be responsible for updating

and maintaining accurate records in ELLevation. _
Full Name CAB Email* Job Title
(Last Name, First Name)

*For Charter Schools only: All correspondence will be communicated via school CAB email
(Ex. charter1234@browardschools.com

CURRENT Users. Staff member that is currently the ESOL Contact at your school and is

_responsible for updating and maintaining accurate records in ELLevation.
Full Name CAB Email* Job Title
(Last Name, First Name)
Q Please check box if identified personnel attended ELLevation training.
Login information will be emailed to the identified personmnel with a cc to the school

INACTIVE Users. Staff that no longer needs access, have left your school or are no longer
responsible for ESOL records.
Full Name CAB Email* Job Title
(Last Name, First Name)




ESOL Parent Leadership Council
2018-2019

CHAIR
Maria Gabriela Salas
VICE-CHAIR
Elizabeth Laverde
SECRETARY
Dinorah Rodriguez

Upcoming Meeting:

Thursday, May 30, 2019
10:00 a.m. — 12:00 p.m.
Southwest Regional Library
16835 Sheridan St. Pembroke Pines, FL 33331




PARENT OUTREACH CENTERS

Park Ridge ES — Open Thursdays
Tamarac ES — Open Mondays
Oriole ES — Open Thursdays
Ovireach Office - Daily 8:00 a.m. to 4:00 p.m.

For more information call the Parent Quitreach Office at

/54-321-2951

BROWARD COUNTY PUBLIC SCHOOLS




@BrowardESOL

Broward
Bilingual
ESOL
Department Broward
ESOL

% Follow Us On Social Media _

0
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Thanks for all you do!




BILINGUAL

D EPAIRTME N T¢

Vicky B. Saldala, Director
Leyda Sotolongo, ESOL Curriculum Supervisor
Stephanie Bustillo, Educational Specialist
Melinda Mayers, Educational Specialist
Monica Nelsas, Parent Qutreach Specialist
Blanca Guerra, World Language Curriculum Supervisor
Idalina Orta, Dual Language Specialist
Reina Murray , Bilingual Guidance Counselor
Celina Chavez, Educational Specialist, Charter School
Support

/54-321-2590 KCW
/54-321-2951- Pembroke Pines

http://esol.browardschools.com _



http://esol.browardschools.com/

